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Prezentacja symulatora SimJunior 
SimJunior jest realistycznie skonstruowanym, naturalnej 
wielkości manekinem pacjenta pediatrycznego, służącym do 
symulacji w procesie szkolenia – indywidualnego i zespołowego 
– personelu medycznego reprezentującego różne dziedziny 
wiedzy medycznej. 
 
Symulator SimJunior jest dostarczany w stanie całkowicie 
złożonym. Części manekina nie wymagają montażu. 
 
Szczegółowe informacje dotyczące przygotowania manekina 
SimJunior do symulacji zawiera „Przygotowanie manekina“. 
 
SimJunior jest dostępny w wersjach: 
− Standardowej 232-000XX 
− Zaawansowanej, ze standardowym zestawem urządzeń 

peryferyjnych 233-100XX 
− Zaawansowanej, ze kompletnym zestawem urządzeń 

peryferyjnych 233-100XX 
 

Uwaga: Symbol „XX“ oznacza wersję językową. 
Dostępne są manekiny w dodatkowych wersjach 
konfiguracji. Więcej informacji można uzyskać 
u lokalnego przedstawiciela firmy Laerdal. 

 
Pomoc w posługiwaniu się symulatorem 
SimJunior 
 
Instrukcja użytkowania 
Zawiera wskazówki i ilustracje demonstrujące krok po kroku 
sposób korzystania z symulatora SimJunior. 
 
Instrukcje użytkowania dostarczone przez 
producentów komponentów 
 
Należy przestrzegać wszystkich odrębnych instrukcji 
i informacji zawartych w oznaczeniach pochodzących od 
producentów komponentów wchodzących w skład manekina. 
Instrukcja użytkowania symulatora SimJunior nie zastępuje, ani 
nie zmienia instrukcji producenta komponentów. 
 
Skrócona instrukcja montażu symulatora SimJunior 
 
Przewodnik ukazujący krok po kroku proces przygotowania do 
użycia systemu symulacji SimJunior. 
 
Instrukcja użytkowania VitalSim 
Instrukcja użytkowania VitalSim dostarcza wskazówek 
dotyczących używania z symulatorem SimJunior jednostki 
sterującej VitalSim i pilota. 
 
Pliki z informacjami pomocniczymi dotyczącymi 
oprogramowania 
 

Pliki z informacjami pomocniczymi dotyczącymi 
oprogramowania dostępne są w menu Pomoc programu 
SimJunior. Tematy informacji pomocniczych: 
− Interfejs programu użytkowego instruktora 
− Przeglądarka raportów 
− Edytor scenariuszy 
− Edytor programów obsługi 
− Edytor trendów 
 

Pomoc techniczna 
W sprawach pomocy technicznej prosimy kontaktować się 
z miejscowym Centrum Obsługi Technicznej Laerdal. 

Materiały pobierane z sieci 
Ze strony http://www.laerdal.com można pobrać najnowsze 
wersje instrukcji użytkowania i oprogramowania systemu 
SimJunior. 
 
Strona internetowa SimCenter zawiera informacje 
o dodatkowych produktach, akcesoriach i oprogramowaniu 
szkoleniowym. System SimJunior w wersji zaawansowanej 
(Advanced) dostarczany jest z Zestawem powitalnym 
SimCenter, zawierającym talon uprawniający do pobrania 
darmowych scenariuszy z witryny SimStore. Więcej informacji 
na stronie www.mysimcenter.com. 
 
 
 
Informacje prawne 
Urządzenie odpowiada wymogom Działu 15 Przepisów 
Federalnej Komisji Łączności (FCC). Działanie urządzenia musi 
spełniać dwa następujące warunki: 
 
1.  Urządzenie nie może powodować szkodliwych zakłóceń 

radiowych. 
2.  Urządzenie musi przyjmować wszelkie odebrane 

zakłócenia radiowe, w tym również zakłócenia mogące 
być przyczyną nieprawidłowego działania. 

 
Uwaga 
Zmiany lub modyfikacje nie zatwierdzone formalnie przez 
stronę odpowiedzialną za zachowanie zgodności z wymogami 
przepisów mogą spowodować unieważnienie uprawnienia 
użytkownika do obsługiwania urządzenia. 
 

Firma Laerdal Medical AS oświadcza niniejszym, że 
oznaczenie niniejszego produktu symbolem CE 
oznacza, iż spełnia on zasadnicze wymagania i inne 
ważne zalecenia dyrektywy 1999/5/EWG 
 
Usuwać zgodnie z obowiązującymi lokalnie 
wymaganiami i przepisami. 
 
Akumulatorki litowo-jonowe należy utylizować. 

 
Klauzula ograniczenia odpowiedzialności 
Systemu symulacji pacjenta SimJunior można używać do 
szkolenia pracowników pod nadzorem odpowiednio 
przeszkolonego personelu medycznego zaznajomionego 
z zasadami kształcenia i ogólnie przyjętymi protokołami 
medycznymi. Podobnie, jak w przypadku wszelkich innych 
manekinów lub podobnych urządzeń szkoleniowych, mogą 
występować niedokładności, odchylenia i nieścisłości 
w cechach anatomicznych i modelowaniu fizjologicznym. Z tego 
względu firma Laerdal nie może ręczyć za całkowitą 
dokładność wszystkich cech manekina 
 
Gwarancja ogólna 
Zob. broszura z Gwarancją ogólną firmy Laerdal Global lub 
strona www.laerdal.com. 
 
Kraj pochodzenia - Symulator SimJunior został wyprodukowany 
w USA. 
 
Laerdal Medical 
P.O. Box 38 
226 FM 116 
Gatesville, Texas 76528, USA 
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Pielęgnacja manekina 
Przestrzeganie podanych niżej wskazówek ma ogromne 
znaczenie dla optymalnego funkcjonowania i trwałości 
elementów manekina. 
 
Zasady pielęgnacji ogólnej 
Aby zachować w odpowiednim stanie skórę manekina, należy 
zawsze kłaść go na czystej powierzchni i myć ręce przed sesją. 
Zalecenia producenta: 
− W trakcie sesji symulacyjnych należy używać rękawic. 

Unikać używania barwionych rękawic z tworzyw sztucznych, 
gdyż mogą spowodować zmianę barwy skóry manekina. 

− Chronić manekin przed poplamieniem pisakami, 
długopisami, acetonem, jodyną lub wywołującymi plamy 
medykamentami. Nie kłaść manekina na papierze 
gazetowym, ani innej zadrukowanej powierzchni. Powstałe 
plamy mogą okazać się nie do usunięcia. 

− Skórę manekina należy myć wodą z mydłem. 
 
Niżej wymienionych technik nie można ćwiczyć z użyciem 
manekina z uwagi na brak możliwości odpowiedniego 
odkażenia dróg oddechowych: 
 
− Wentylacja usta-usta i usta-maska 
− Wprowadzania sztucznych wymiocin i płynów do odsysania 
− Jeśli sesja szkoleniowa obejmuje wprowadzanie płynów do 

ręki z dostępem dożylnym, bezpośrednio po sesji należy 
odsączyć płyny z ręki. 

− Stosować wyłącznie lubrykant  do dróg oddechowych 
Laerdal. Lubrykant należy używać z umiarem. 

− Opłukać, oczyścić i wysuszyć wchodzące w skład manekina. 
− Odwinąć skórę torsu i posypać talkiem jej wewnętrzną 

stronę, aby zmniejszyć tarcie. Uważać, aby nie wsypać talku 
do wnętrza klatki piersiowej. 

 
Środowisko 
W chłodnych warunkach nie należy uruchamiać manekina 
dopóki nie ogrzeje się do temperatury pokojowej. 
 
Zapobieganie przegrzaniu i ograniczanie zużycia manekina: 
− Gdy manekin jest używany w temperaturze przekraczającej 

40°C (104°F), należy koniecznie umożliwić jego schłodzenie 
pomiędzy sesjami szkoleniowymi. 

− Ułożonego na łóżku manekina nie należy zbytnio okrywać 
pościelą, aby nie zakłócać wymiany powietrza. 

Uwagi dot. obchodzenia się z manekinem 
Stosowanie podanych niżej środków ostrożności pozwoli 
zapobiec ewentualnym obrażeniom ciała i uszkodzeniom 
produktu: 
 
− Niezgodne z niniejszą instrukcją wprowadzanie płynów do 

manekina może spowodować uszkodzenie manekina i jego 
elementów. 

− Przed wprowadzeniem narzędzia, rurki lub przyrządu do 
dróg oddechowych należy spryskać ustną i nosową część 
dróg oddechowych dostarczonym lubrykantem. Również 
przyrządy i rurki muszą być naoliwione przed użyciem. 

− Nie wprowadzać wilgotnego powietrza do układu w trakcie 
wentylacji. 

− Nie wolno używać manekina, jeśli odłączone są wewnętrzne 
rurki i kable. 

− Używanie manekina SimJunior na zewnątrz pomieszczeń, 
w warunkach dużej wilgotności, grozi porażeniem 
elektrycznym lub uszkodzeniem urządzenia. 

− Stosowanie defibrylatora w temperaturze przekraczającej 
35°C (95°F) może doprowadzić do przegrzania manekina. 

 
Ostrzeżenie: Do uciśnięć klatki piersiowej manekina 
nie wolno używać urządzeń wykonujących takie 
uciśnięcia automatycznie. 
 
Uwaga – lateks: Produkt zawiera lateks Natural 
Rubber, który może powodować reakcje alergiczne. 

 
Zagrożenia związane z defibrylacją 
Manekin SimJunior umożliwia wykonywanie defibrylacji. 
 
Można do tego celu używać konwencjonalnego defibrylatora. 
W trakcie defibrylacji zarówno defibrylator, jak i manekin 
stanowią potencjalne źródło zagrożenia porażeniem 
elektrycznym. Używając defibrylatora do zabiegów na 
manekinie należy zachować wszelkie standardowe środki 
ostrożności. 
 
1.  Należy przeczytać instrukcję eksploatacji dostarczoną 

z defibrylatorem i dołączonymi urządzeniami 
i przestrzegać podanych w niej zaleceń. 

2.  Zgodnie z protokołem defibrylacyjnym, podczas 
defibrylacji należy unikać kontaktu między elektrodami 
zewnętrznymi i miejscem przykładania elektrod. 
Maksymalna dostarczona energia to 300 dżuli. 

3.  Nieprzestrzeganie zaleceń dotyczących bezpieczeństwa 
grozi obrażeniami ciała lub śmiercią. 

 
Więcej informacji zawiera Instrukcja użytkowania defibrylatora. 
 

Ostrzeżenia: 
 

− Do defibrylacji należy używać złączy defibrylacyjnych lub 
płytek wmontowanych w klatkę piersiową manekina. Złącza 
EKG są przystosowane wyłącznie do monitorowania 
elektrokardiogramu i nie wolno ich używać do defibrylacji. 
Defibrylacja na złączach EKG spowoduje uszkodzenie 
wewnętrznej elektroniki manekina, grozi również obrażeniami 
ciała. 

− Nie wolno wykonywać defibrylacji, gdy manekin jest 
wyłączony lub nie działa prawidłowo. 
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Aby nie dopuścić do przegrzania manekina, defibrylację należy 
przeprowadzać w 45-sekundowych sekwencjach obejmujących 
nie więcej niż 3 wstrząsy i przedzielonych 1-minutowym 
zabiegiem resuscytacji. Po 30 minutach należy przerwać 
aplikowanie wstrząsów. Kolejną sekwencję można rozpocząć 
nie wcześniej niż po upływie 15 minut. Cała sesja defibrylacji 
nie może trwać dłużej niż 4 godziny. Nie wolno również 
aplikować więcej niż dwa wstrząsy o energii 300 dżuli na 
minutę. 
 

Ostrzeżenia: 
 

− W trakcie defibrylacji manekin nie może pozostawać 
w kontakcie z powierzchnią lub przedmiotami 
przewodzącymi elektryczność. 

− Manekina nie należy używać w środowisku zawierającym 
substancje łatwopalne, na przykład w trakcie defibrylacji 
należy unikać wysokich poziomów czystego tlenu. Jeśli 
w pobliżu manekina stosowany jest stężony tlen, należy 
zapewnić odpowiednią wentylację. 

− Tors manekina należy utrzymywać stale w stanie suchym. 
− Przed defibrylacją należy odczekać, aż temperatura 

manekina zrówna się z temperaturą otoczenia. Gwałtowne 
zmiany temperatury mogą spowodować skraplanie się pary 
na komponentach elektronicznych, co grozi porażeniem 
elektrycznym. 

− Nie wolno stosować żelu defibrylacyjnego, ani elektrod 
defibrylacyjnych używanych w rzeczywistych zabiegach 
defibrylacyjnych. Może to spowodować powstanie skaz 
punktowych na skórze manekina. 

− Zbyt silny nacisk na złącza defibrylacyjne w trakcie 
defibrylacji również może powodować wyładowania łukowe 
i skazy. 

− Nie wolno defibrylować manekina, gdy zdjęta jest skóra 
torsu. 

 
Zagrożenia mechaniczne lub elektryczne 
Manekina SimJunior nie należy używać, jeśli: 
− Kończyny nie są przymocowane do torsu. 
− Skóra jest rozerwana lub niewłaściwie przymocowana. 
− Uszkodzone są zewnętrzne przewody, rurki lub złączki. 
− Nastąpił wyciek płynu wewnątrz lub na zewnątrz manekina. 
− Manekin wydaje dziwne dźwięki wskazujące na wypływ 

powietrza lub uszkodzenie mechaniczne. 
− Występują objawy wadliwego działania układu 

elektrycznego, jak brak reakcji manekina, dziwny zapach lub 
dym. 

 
Ostrzeżenie: 
 

− Unikać ryzyka przycięcia palców – nie wolno używać 
manekina bez skóry zewnętrznej. 

 
Użycie i konserwacja akumulatorka 
− Należy używać wyłącznie akumulatorków zatwierdzonych do 

użytku z manekinem SimJunior, jednostką VitalSim i pilotem. 
− Akumulatorki muszą być prawidłowo zainstalowane. 

Nieprawidłowe włożenie i podłączenie akumulatorków może 
być przyczyną zwarcia. 

 
Ostrzeżenia: 

 
− Akumulatorki należy usuwać zgodnie z lokalnie 

obowiązującymi przepisami. 
− Ładowarki zewnętrznej można używać tylko wewnątrz 

pomieszczeń. 

− Akumulatorki manekina należy ładować wyłącznie 
w temperaturze nie niższej niż 0°C i nie wyższej niż 40°C 
(32°F - 104°F) 

− Niedopuszczalne jest niewłaściwe obchodzenie się 
z akumulatorkami, demontowanie ich lub próby naprawy. Nie 
wolno używać akumulatorków, które mają widoczne 
uszkodzenia, są niesprawne lub nieszczelne. 

− Należy zachować szczególną ostrożność, aby nie dopuścić 
do bezpośredniego kontaktu z elektrolitem, częściami 
gorącymi lub wydzielającymi dym. W razie wycieku 
z akumulatorka należy go odłączyć i wyjąć, jeśli nie zagraża 
to bezpieczeństwu. 

− Zalanie akumulatorka grozi wybuchem. 
− Po każdych 30 cyklach ładowania należy przed ponownym 

załadowaniem rozładować całkowicie baterie. W tym celu 
należy używać manekina pracującego na obu 
akumulatorkach aż do momentu automatycznego 
wyłączenia. 

− Zużyte akumulatorki należy zastąpić wyłącznie oryginalnymi 
bateriami SimJunior firmy Laerdal. 

 
Przechowywanie i transport 
− Nie należy przechowywać całkowicie naładowanych 

akumulatorków dłużej niż przez miesiąc. 
− Manekin można przewozić transportem lotniczym 

z zainstalowanymi akumulatorkami. 
− W przypadku transportu zapasowych akumulatorków 

wskazany jest kontakt z liniami lotniczymi lub firmą 
spedycyjną w celu uzyskania informacji o aktualnych 
przepisach transportowych. 

 

Ostrzeżenie: 
 
− Waliza z manekinem SimJunior i akcesoriami jest ciężka. 

W trakcie transportu i przechowywania należy odpowiednio 
zabezpieczyć manekin, aby zapobiec możliwym obrażeniom 
lub uszkodzeniu produktu. 
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Symulator SimJunior 
 
 
 
 
 
 
 
 
 
 
 
 
Złącze EKG prawej ręki 

            Złącze EKG lewej ręki 
Płytka defibrylacyjna mostka 
 
 
 

Ramię IV          Ręka do pomiaru ciśnienia krwi 
 
 
             

Płytka defibrylacyjna okolicy koniuszkowej 
 
Złącze EKG prawej nogi         Złącze EKG lewej nogi 
 
 
 
 
 
 
 
 
 
 
Przewód zasileniowy 
 
Zewnętrzne złącze powietrza   
 
Przewód szeregowy 37-wtykowy 
 
Noga z dostępem śródkostnym  
 
 
 
 
Otwór napełniania nogi z dostępem śródkostnym 
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Symulator SimJunior 
Symulator SimJunior stanowi pomoc w interaktywnym 
szkoleniu w zakresie umiejętności ratowania życia. Urządzenie 
reaguje na interwencje kliniczne, polecenia instruktora 
i informacje z zaprogramowanych scenariuszy, ułatwiając 
uczestnikom nabywanie w wprawy w skutecznym 
diagnozowaniu i leczeniu pacjenta. 
 
Dzięki takim właściwościom klinicznym, jak spontaniczne 
oddychanie, kontrolowanie dróg oddechowych, emisja głosu, 
dźwięków, sygnałów EKG SimJunior jest w pełni funkcjonalnym 
symulatorem pacjenta pediatrycznego. SimJunior umożliwia 
obserwowanie i rozpoznawanie większości objawów czynności 
życiowych, co pozwala instruktorowi oceniać umiejętności 
ćwiczących na podstawie realistycznych sytuacji klinicznych. 
 
Właściwości symulatora SimJunior 
− Realistycznie wymodelowane drogi oddechowe służące do 

symulacji trudnych zabiegów oraz intubacji ustnej i nosowej. 
− Dostrzegalny oddech. 
− Możliwość symulacji zabiegów kardiologicznych, w tym 

defibrylacji i kardiowersji. 
− Oczy z wymiennymi źrenicami (normalnych, poszerzonych 

i zwężonych). 
− Konwulsje symulujące napady. 
− Uciśnięcia klatki piersiowej. 
− Dostęp naczyniowy. 
− Prawidłowe i nieprawidłowe tony serca, dźwięki oddechowe 

i dźwięki jelit. 
− Automatyczne kontrolowanie symulacji oparte na 

zaprogramowanych i zatwierdzonych scenariuszach 
pacjenta. 

 
Symulacje mogą być przeprowadzane w trybie autonomicznym, 
z użyciem scenariuszy. Zmiany w stanie pacjenta są z góry 
zaprogramowane i zachodzą w automatycznie w reakcji na 
interwencje uczestnika szkolenia. 
 
Wymiary ogólne 
Długość/szerokość (sam manekin): 48 cali x 9,84 cali (120 cm x 
42,5 cm) 
Ciężar (sam manekin): 25 funtów (11,36 kg) 
 
Ubranie manekina SimJunior 
Manekin SimJunior dostarczany jest w specjalnie 
zaprojektowanym ubraniu, z zapięciami na rzepy ułatwiającymi 
rozbieranie. Na przywieszce ubrania można znaleźć instrukcję 
prania. 
− Koszula 
− Szorty 
− Bokserki 
 
Ogólne właściwości kliniczne 
Właściwości dróg oddechowych 
Drogi oddechowe mają prawidłowo wymodelowane cechy 
anatomiczne do poziomu tchawicy. Na drogach oddechowych 
można wykonywać następujące zabiegi: 
− Odchylenie głowy / uniesienie podbródka. 
− Odsunięcie żuchwy połączonej stawem z głową. 
− Ucisk i zabieg na chrząstce pierścieniowatej krtani. 
− Odsysanie (ustne i nosowo-gardłowe) 
Manekin można wentylować metodami normalnymi 
i stosowanymi w nagłych wypadkach; 

− Wentylacja za pomocą worka samorozprężalnego 
− Intubacja dotchawicza przez usta 
− Intubacja dotchawicza przez nos 
 
Przed użyciem przyrządów do dróg oddechowych należy 
naoliwić je lubrykantem Laerdal Airway Lubricant. 
 
Na drogach oddechowych manekina można ćwiczyć 
stosowanie: 
− Maski krtaniowej (rozmiar nr 2.5). 
− Rurki dotchawiczej (średnica wewnętrzna 4,5 z mankietem, 

5,5 bez mankietu). 
 
Zaleca się używanie podatnego usztywniacza. Należy 
sprawdzić, czy nie sięga on poza rurkę dotachawiczą. 
 
Niżej wymienione stany manekina są objawem 
nieprawidłowego umieszczenia rurki: 
− Intubacja prawego pnia oskrzeli – jednostronne uniesienie 

klatki piersiowej. 
− Rozdęcia żołądka. 
− Brak dźwięków klatki piersiowej (zob. punkt „Oddychanie“). 
 
Właściwości manekina można konfigurować na potrzeby 
prezentacji różnych scenariuszy dotyczących dróg 
oddechowych: 
− Obrzęk języka – poziom normalny, średni, maksymalny. 
− Otwarte lub zamknięte płuca. 
 
Właściwości symulacji oddychania 
SimJunior może symulować spontaniczne oddychanie 
z widocznym unoszeniem się i opadaniem klatki piersiowej 
i zmienną częstością oddechu. Oddychanie jest generowane 
przez sprężarkę powietrza zainstalowaną w prawym udzie 
manekina. 
− Obustronne unoszenie i opadanie klatki piersiowej przy 

oddychaniu spontanicznym. 
− Jednostronne unoszenie się i opadanie klatki piersiowej przy 

nieprawidłowej intubacji oskrzela głównego 
− Dźwięki oddechowe jednostronne i dwustronne. 
− Prawidłowe i nieprawidłowe dźwięki oddechowe. 
− Zmienna częstość oddechu (0-60 oddechów na minutę). 
− Miejsca osłuchiwania przednie (4). 
 
Oba płuca można zamykać osobno i razem, aby symulować 
częściową lub całkowitą niedrożność dróg oddechowych. Na 
manekinie SimJunior można również ćwiczyć wentylację 
wspomaganą. 
 

Uwaga: Płuca nie są przystosowane do używania 
z zastawkami utrzymującymi dodatnie ciśnienie 
w końcowej fazie wydechu (PEEP). 
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Właściwości krążenia 
Właściwości dot. serca: 
− Obszerna biblioteka impulsów z zapisu EKG w przedziale 0-

200. 
− Tony serca – położenie przednie (1). 
− Monitorowanie rytmów EKG (EKG z 4 złączy 3 

odprowadzeń). 
− Wyświetlanie 12-odprowadzeniowego EKG (tylko SimJunior 

w wersji zaawansowanej). 
− Elektrostymulacja serca. 
− Defibrylacja i kardiowersja z użyciem defibrylatorów pod 

napięciem. 
 
Defibrylacja: 
− Liczby wstrząsów potrzebne do automatycznej konwersji są 

ustalone w każdym z symulowanych przypadków 
chorobowych. 

 
Złącza kołkowe defibrylacyjne 
 
 
 
 
 
 
 
 
 
 
 
 
 
Złącza 3-odprowadzeniowego EKG 
 
 
 
 
 
 
 
 
 
 
 
 
 
Ciśnienie krwi i tętna: 
− Ciśnienie krwi mierzone ręcznie metodą osłuchiwania 

odgłosów Korotkoffa. 
− Obustronne tętno szyjne. 
− Tętna centralne można ustawić na poziomi normalnym, 

słabym i zerowym (brak tętna). 
− Tętna promieniowe/ramieniowe można ustawić na poziomi 

normalnym, słabym i zerowym (brak tętna). 
− Tętna: szyjne, ramieniowe i promieniowe są 

zsynchronizowane z EKG. 
− Siła tętna zmieniająca się odpowiednio do zmian ciśnienia 

tętniczego. 
− Wykrywanie i rejestrowanie badania palpacyjnego tętna. 

Właściwości w zakresie resuscytacji krążeniowo-
oddechowej 
 

− Symulacja zgodna z wytycznymi dot. resuscytacji z 2010. 
− Uciśnięcia generują wyczuwalne dotykiem tętno, kształt fali 

ciśnienia krwi i artefakty EKG. 
− Głębokość uciśnięć i opór zgodne z realiami. 
− Wykrywanie głębokości i częstości uciśnięć. 
 
 
Właściwości układu naczyniowego 
Dostęp dożylny: 
Miejsce dostępu dożylnego na prawej dłoni i przedramieniu. 
Ręki z dostępem dożylnym można użyć do symulacji 
wprowadzania dożylnego, wlewów i podawania pozajelitowego 
do żył: 
− obwodowych przedramienia; 
− zgięcia łokciowego i grzbietu dłoni. 
 
W sprawie użycia cewnika (wyposażenie dodatkowe) należy 
skontaktować się z lokalnym przedstawicielem firmy Laerdal. 
 
 
Dostęp śródkostny: 
Miejsca wykonywania wlewów śródkostnych: 
− Guz piszczelowy (prawy) 
− Kostka przyśrodkowa 
 
 

Uwaga: Na manekinie SimJunior nie ma miejsc do 
wykonywania wstrzyknięć domięśniowych. Nie należy 
próbować wykonywać takich wstrzyknięć. 

 
 
Ustawienia dźwięków w manekinie 
SimJunior 
 
Na manekinie SimJunior znajduje się wiele miejsc służących do 
osłuchiwania i rozpoznawania tonów serca oraz dźwięków płuc 
żołądka i jelit. SimJunior umożliwia również symulowanie 
dźwięków głosowych. 
 
Informacje dotyczące ustawiania dźwięków w manekinie 
SimJunior zawierają punkty: 
− „System standardowy SimJunior“. 
− „System zaawansowany SimJunior“. 
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Jednostka sterująca VitalSim 
Połączona z manekinem jednostka sterująca VitalSim 
umożliwia symulowanie z użyciem manekina SimJunior 
różnych sytuacji z zakresu opieki klinicznej i pomocy w nagłych 
przypadkach. 
 
Do kierowania symulacjami manekina SimJunior w wersji 
standardowej służy urządzenie zdalnego sterowania VitalSim. 
 
Symulacjami manekina SimJunior w wersji zaawansowanej  
można kierować za pomocą komputera instruktora lub 
urządzenia zdalnego sterowania VitalSim. 
 

Uwaga: Komputera instruktora i pilota nie można 
używać równocześnie. 

 
Zestaw VitalSim zawiera płytkę CD z oprogramowaniem 
pomocnym przy realizacji funkcji scenariuszy i raportów. 
Oprogramowanie może działać w środowisku Windows XP 
i Windows 7. 
 
Jednostkę sterującą VitalSim można podłączyć do komputera 
za pośrednictwem złącza USB. Korzystając z tego połączenia 
można wprowadzać do jednostki VitalSim scenariusze 
przygotowane na komputerze, a także aktualizować 
oprogramowanie. Raporty generowane i zapisywane 
w jednostce VitalSim można, po wgraniu do komputera, 
przeglądać, drukować i trwale przechowywać. 
 
Informacje o funkcjach oprogramowania można znaleźć 
w pomocy programu i dokumentach znajdujących się na płytce. 
Uwaga: Szczegółowe informacje na temat działania jednostki 
sterującej VitalSim i pilota zawiera Instrukcja użytkowania 
VitalSim. 
 

Po ustawieniu jednostki sterującej VitalSim i manekina należy 
połączyć jednostkę z manekinem 37-wtykowym przewodem 
szeregowym (przewód połączeniowy manekina). 
1.  Włączyć jednostkę sterującą VitalSim, naciskając jeden 

raz przycisk On/Off. 
2.  Ponowne naciśnięcie przycisku On/Off spowoduje 

wyłączenie jednostki sterującej VitalSim. 
3.  Jeśli jednostka sterująca ma kontakt z pilotem, świeci się 

zielona lampka wskaźnika. W tym momencie system jest 
gotowy do użycia. 

4.  Brak kontaktu jednostki sterującej z pilotem sygnalizowany 
jest miganiem zielonej lampki wskaźnika. Sprawdzić 
połączenia i baterie, aby ustalić przyczynę problemu. 

 
Uwaga: Jeśli bateria jednostki VitalSim wymaga 
wymiany, lampka wskaźnika miga na przemian 
światłem zielonym i czerwonym. 

 
 

 
 

Zawartość zestawu VitalSim 
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Prezentacja symulatora SimJunior w wersji 
standardowej 
 
Wersja standardowa symulatora SimJunior obejmuje: 
− Manekin wraz z torbą 
− Skróconą instrukcję montażu SimJunior 
− Zestaw jednostki sterującej VitalSim 
− Mankiet do pomiaru ciśnienia krwi 
− Zestaw materiałów eksploatacyjnych 
− Oprogramowanie robocze 
− Instrukcję użytkowania symulatora SimJunior 

Skrócony opis konfiguracji systemu 
Na poniższej ilustracji pokazano sposób połączenia elementów 
systemu SimJunior w wersji standardowej. 
1. Podłączyć jednostkę sterującą VitalSim 
− Podłączyć przewód zasilania jednostki VitalSim do gniazdka 

w ścianie. 
2. Podłączyć manekin do jednostki sterującej VitalSim. 
− Podłączyć 37-wtykowy przewód szeregowy (łączący 

manekin z VitalSim) do jednostki sterującej VitalSim. 
− Umieścić mankiet do pomiaru ciśnienia krwi – jeśli ma być 

używany – na lewej ręce manekina. 
− Podłączyć przeźroczystą rurkę mankietu do złącza ciśnienia 

krwi na tylnej ścianie jednostki sterującej VitalSim. 
3. Podłączyć manekin do źródła zasilania 
4. Włączyć zasilanie jednostki sterującej VitalSim. 
5. W tym momencie system symulacji jest gotowy do 

użycia. Po naładowaniu akumulatorków można odłączyć 
przewody zasilania. 

6. Przygotować manekin i jego komponenty zgodnie 
z wymaganiami określonych symulacji (zob. punkt 
„Ustawienia“). Przygotowanie manekina do symulacji. 

 
Uwaga: Jeśli zamiast jednostki sterującej zamówionej 
z symulatorem SimJunior używana jest wcześniejsza 
wersja jednostki, należy zaktualizować oprogramowanie 
stosownie do nowych właściwości SimJunior – zob. 
punkt „„Konserwacja:„ “Instalowanie i aktualizacja 
oprogramowania SimJunior“. 
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Oprócz jednostki sterującej, do sterowania systemem 
SimJunior Standard można używać również pilota. 
Wyposażony w wyświetlacz pilot oferuje zestaw menu i opcji 
opisany w Instrukcji użytkowania VitalSim. 
 
Pilot 
Opisane w tej części Instrukcji użytkowania ekrany 
i właściwości SimJunior dotyczą symulatora w wersji 
standardowej. 
 
Zestaw VitalSim symulatora SimJunior zawiera Instrukcję 
użytkowania. Przed przystąpieniem do pracy z symulatorem 
SimJunior należy zapoznać się z zawartym w instrukcji 
szczegółowym opisem obsługi jednostki sterującej VitalSim 
i pilota. 
 
Po podłączeniu manekina SimJunior do jednostki sterującej 
VitalSim należy włączyć zasilanie VitalSim i pilota. Jednostka 
sterująca VitalSim automatycznie wykryje podłączony manekin 
i przypisze parametrom wartości domyślne. 
 

Uwaga: W trakcie rozruchu można dostrzec drżenie 
głowy manekina, będące objawem autotestu zasilania. 

 

Główne elementy ekranu wyświetlacza 
Ekran pilota służy do wyświetlania aktualnego stanu ogólnego 
manekina i modyfikowania parametrów. 
 
Główny wyświetlacz składa się z obszarów funkcjonalnych i linii 
funkcji (zob. ilustracja niżej). Wyświetlane są informacje 
o parametrach stanu pacjenta i użyciu funkcjonalnych 
elementów sterowniczych. 
 
Za pomocą klawiszów nawigacji przemieścić kratkę wyboru na 
właściwy obszar funkcjonalny wyświetlacza. Po dokonaniu 
wyboru nacisnąć klawisz OK, aby uaktywnić nowy wybór i 
powrócić do ekranu głównego. 
 
Aby anulować wybór, należy wcisnąć C; wyświetlony zostanie 
ekran główny, a ustawienia pozostaną niezmienione. 
 
Menu ustawień pilota 
Włączenie menu ustawień: 
1.  Włączyć zasilanie pilota. 
2.  Nacisnąć klawisz <Menu>. 
3.  Klawiszami nawigacji przemieścić kursor na funkcję po 

lewej stronie ekranu. 
 
 
 
 
 
 
 
 
 
 
4.  Wybierz funkcję. 
5.  Zapisać wybór naciśnięciem klawisza OK. 
6.  Zmienić odpowiednie parametry. 
 

Uwaga: Naciśnięcie klawisza C spowoduje powrót do 
głównego menu bez zapisywania w pamięci 
dokonanych zmian. 

Kalibracja ciśnienia krwi 
Aby zapewnić prawidłowe pomiary symulowanego ciśnienia 
krwi, należy skalibrować sfigmomanometr używany 
z mankietem stosownie do wskazań czujnika w systemie 
SimJunior. 
 
 
 
 
 
 
 
 
 
 
 
1.  Nacisnąć klawisz Menu. 
2.  Przemieścić kursor na funkcję Calibrate BP [Kalibracja 

ciśnienia krwi]. 
3.  Nadmuchać mankiet tak, aby ciśnienie powietrza 

w mankiecie wynosiło 100 mmHg. 
4.  Przy ciśnieniu równym dokładnie 100 mmHg nacisnąć 

klawisz szybkiego wykonania Calibrate [Kalibruj] 
(w prawym dolnym rogu ekranu). 

 
Parametry dróg oddechowych i oddychania 
Klawiszami nawigacji wybrać na głównym ekranie obszar 
funkcyjny oddychania (Breathing), na którym wyświetlana jest 
bieżąca częstość oddechu i stan zamknięcia płuc. 
 
Ustawianie częstości oddechu 
Za pomocą klawiszów nawigacji wybrać obszar funkcyjny 
oddychania (Breathing). 
 
Zmienić częstość oddechu klawiszami szybkiego wykonania 
< + > i < - >, względnie wprowadzić nową częstość 
bezpośrednio, za pomocą klawiszów numerycznych. 
 
Częstość oddechu można ustalić w przedziale od 0 do 100 
oddechów na minutę. 
 
Jeśli ciśnienie krwi ustalono na poziomie zerowym, częstość 
oddechu zostanie natychmiast ustawiona na 0. 
 
Nacisnąć klawisz <Shift> (klawisz strzałki w górę); pojawi się 
alternatywny zestaw funkcji szybkiego wykonania. 
 
Menu ustawiania parametrów dróg oddechowych 
Po wybraniu obszaru funkcyjnego oddychania wywołać 
klawiszem <OK> menu ustawiania parametrów dróg 
oddechowych. Za pomocą klawiszów nawigacji w lewo / 
w prawo wybrać obszar funkcjonalny, a następnie użyć funkcji 
szybkiego wykonania do zmiany ustawień parametrów. 
 
Wyłączanie pilotem sprężarki 
Za pomocą pilota wywołać menu ustawiania parametrów 
(system SimJunior w wersji standard). Wśród pozycji menu 
znajduje się sprężarka. 
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1.  Wybrać <Compressor> [Sprężarka]. Wyświetlone 
zostaną opcje klawiszy szybkiego wykonania. 

2.  Nacisnąć klawisz szybkiego wykonania dla opcji 
wyłączenia (Off). 

 
Na ekranie wyświetlacza, na prawo od menu. powinna pojawić 
się informacja o wyłączeniu sprężarki. 
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Prezentacja wersji zaawansowanej SimJunior 
 
Wersja zaawansowana symulatora SimJunior obejmuje: 
− Manekin wraz z torbą 
− Instrukcja instalacji systemu SimJunior 
− Zestaw jednostki sterującej VitalSim 
− Oprogramowanie robocze jednostki sterującej VitalSim 
− Komputer instruktora 
− Monitor pacjenta z ekranem dotykowym (tylko pełny zestaw urządzeń peryferyjnych) 
− Kamera internetowa ze złączem USB 
− Koncentrator USB 
− Mankiet do pomiaru ciśnienia krwi 
− Zestaw materiałów eksploatacyjnych 
− Oprogramowanie robocze komputera instruktora 
− Instrukcja użytkowania symulatora SimJunior 
− System SimJunior w wersji zaawansowanej (Advanced) dostarczany jest z Zestawem powitalnym SimCenter, zawierającym talon 

uprawniający do pobrania darmowych scenariuszy z witryny SimStore. 
 
 
 
 
 
   
 
 
 
 
Komputer instruktora 
 
 
  
 
 
    Ekran dotykowy monitora pacjenta 
 
 
 
 
 
 
   
 
Kamera sieciowa 
 
 
 
Do zarządzania symulacjami służy komputer instruktora. Dołączono programy komputerowe służące do opracowywania 
i edytowania scenariuszy, a także aplikację tworzącą sprawozdania z sesji symulacyjnych na podstawie ujęć z kamery internetowej i 
komputera monitorowania pacjenta. 
 
Monitor pacjenta można konfigurować w sposób umożliwiający tworzenie replik większości monitorów pacjenta. Monitor pacjenta 
służy również do wyświetlania wyników innych funkcji, np. elektrokardiogramu z 12 odprowadzeń, rentgenogramów i wyników badań 
laboratoryjnych na potrzeby prezentacji historii choroby pacjenta. 
 
Kamera internetowa rejestruje w trakcie sesji symulacji obraz i dźwięk, które później wykorzystywane są w trakcie sesji 
sprawozdawczej. 
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Skrócony opis konfiguracji systemu 
Uwaga: Szczegółowe wskazówki na temat wstępnego ustawienia parametrów systemu można znaleźć w Skróconej 
instrukcji montażu SimJunior 
. 

1. Uruchomić komputer instruktora 
− Podłączyć mysz i zasilacz do komputera i włączyć zasilanie. 
− Ikonka symulatora SimJunior powinna pojawić się na pulpicie komputera instruktora 
 
2. Zainstalować koncentrator USB 
− Podłączyć zasilanie do koncentratora USB. 
− Podłączyć koncentrator USB do komputera instruktora. 
 
3. Podłączyć przewody monitora pacjenta 
− Odłożyć płytkę z oprogramowaniem dostarczoną wraz z monitorem. NIE INSTALOWAĆ oprogramowania z płytki CD. 
− Przeprowadzić kable przez stojak monitora pacjenta i podłączyć je do odpowiednich gniazdek umieszczonych u dołu ekranu. 

-- Kabel wideo 
-- Kabel USB 
-- Kabel audio (niebieski wtyk miniaturowy z pojedynczym przewodem) 
-- Kabel zasileniowy 
-- Zabezpieczyć kable za pomocą odprężaczy. 

− Podłączyć przewód zasileniowy do gniazdka w ścianie i włączyć zasilanie monitora pacjenta. 
 
4. Podłączyć kabel wideo z monitora pacjenta i 3-przewodowy kabel audio (czarny wtyk miniaturowy z podwójnym 

przewodem) do komputera instruktora. 
 

WAŻNE! Nie podłączać na razie kabla USB do monitora pacjenta. 
 
5. Ustawić na komputerze instruktora opcję podłączenia pulpitu zdalnego, aby umożliwić obsługę monitora pacjenta. 
− Kliknąć prawym klawiszem myszy na pulpicie komputera instruktora 
− Z menu rozwijanego wybrać <Screen Resolution> [Rozdzielczość ekranu] 
− Z opcji <Multiple Displays> [Wiele wyświetlaczy] wybrać <Extend these displays> [Dodaj wyświetlacze]. 
− Wybrać <Apply> [Zastosuj]. 
− Komputer instruktora (wyświetlacz 1) powinien mieć rozdzielczość 1600 x 900. 
− Monitor pacjenta (wyświetlacz 2) powinien mieć rozdzielczość 1280 x 1024. 
− Wybrać <OK>. 
 
6. Podłączyć monitor pacjenta do koncentratora USB. 
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7. Skalibrować monitor pacjenta z ekranem dotykowym. 
 
− Prawym klawiszem myszy kliknąć na logo ELO na pulpicie, w prawym dolnym rogu ekranu. 
− W wyświetlonym oknie dialogowym kliknąć na przycisku <Align> [Wyrównaj]. 
− Jeśli wskaźniki wynikowe pojawią się najpierw na ekranie komputera, nacisnąć <Esc>, lub odczekać, aż pojawią się one na 

monitorze pacjenta. 
− Gdy wskaźnik wynikowy pojawi się na monitorze pacjenta, należy dotknąć każdego wskaźnika w momencie zmiany jego 

położenia. 
− Po wyświetleniu okna dialogowego ekranu dotykowego ELO dotknąć zielonego przycisku „pole wyboru“. 
− Wybrać <OK>. 

8. Podłączyć kamerę USB do koncentratora USB. 
 
9. Podłączyć jednostkę sterującą VitalSim. 
 
− Podłączyć kabel USB z jednostki sterującej VitalSim do koncentratora USB. 
− Podłączyć kabel audio (biały wtyk miniaturowy z pojedynczym przewodem) do jednostki sterującej. 
− Podłączyć kabel zasileniowy do jednostki sterującej i źródła prądu. 
 
10. Podłączyć manekin do jednostki sterującej VitalSim. 
 
− Podłączyć 37-wtykowy przewód szeregowy (łączący manekin z VitalSim) do jednostki sterującej VitalSim. 
− Założyć mankiet ciśnienia krwi na lewą rękę manekina. 
− Podłączyć przeźroczystą rurkę mankietu do złącza ciśnienia krwi na tylnej ścianie jednostki sterującej VitalSim. 
− Podłączyć manekin do źródła zasilania. 
− Włączyć zasilanie jednostki sterującej. 
 
W tym momencie system symulacji jest gotowy do użycia. 
 
Przygotować manekina i jego komponenty potrzebne do określonych symulacji – zob. punkt „Konfiguracja manekina”. 
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Licencja na oprogramowanie 
 
Komputer instruktora dostarczany jest przez firmę Laerdal Medical z zainstalowaną aktywną licencją. 
 
Zmiany lub modernizacje sprzętu komputerowego (np. zainstalowanie nowego dysku twardego lub płyty głównej) mogą spowodować 
unieważnienie licencji. W sprawie ponownego uaktywnienia licencji prosimy kontaktować się z lokalnym przedstawicielem firmy 
Laerdal. 
 

Komputer instruktora 
 
Komputer instruktora używa oprogramowania aplikacji instruktora do zarządzania scenariuszami symulacji. Instruktor może 
przerwać realizację scenariusza w dowolnym momencie i prowadzić symulację w trybie ręcznym (bieżącym), dostosowując, 
stosownie do potrzeb, parametry pacjenta. 
 
Więcej informacji na temat oprogramowania i ustawiania parametrów systemu można znaleźć w plikach pomocy: 
 
1.  Z menu Windows wybrać <Start> <All programs> [Wszystkie programy]. 
2.  Wybrać <SimJunior Instructor Application> [Program użytkowy instruktora]. 
3.  Wybrać <SimJunior Help File> [Plik pomocy SimJunior]. 
 
 
Opis ekranu aplikacji instruktora 
Ekran aplikacji instruktora zawiera obszary funkcjonalne służące do przeglądania i kontrolowania właściwości klinicznych pacjenta. 
 
1. Pasek menu programu  7. Protokół raportów 
2. Ustawianie układu 

oddechowego  
8. Ustawianie trendów 

i programów obsługi 
3. Ustawianie dźwięków, dróg 

oddechowych i krążenia 
symulatora 

9. Bieżące trendy 

4. Ustawianie defibrylacji 
i elektrostymulacji serca 

10. Okno trendów 

5. Ustawianie monitora 
instruktora 

11. Bieżące programy obsługi 

6. Okna zdarzeń  12. Ustawianie scenariuszy 
 13. Ustawianie drgawek 
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       9      8        11             10 
 
 

1. Pasek menu programu  7. Protokół raportów 
2. Ustawianie układu oddechowego  8. Ustawianie trendów i programów obsługi 
3. Ustawianie dźwięków, dróg oddechowych i krążenia 

symulatora 
9. Bieżące trendy 

4. Ustawianie defibrylacji i elektrostymulacji serca 10. Okno trendów 
5. Ustawianie monitora instruktora 11. Bieżące programy obsługi 
6. Okna zdarzeń  12. Ustawianie scenariuszy 
 13. Ustawianie drgawek 

 
 
Opis funkcji: 
1. Pasek menu programu 
− Otwarcie i edycja pliku. 
− Ustawienie parametrów i konfigurowanie monitora pacjenta 

i symulatora. 
− Dostęp do dodatkowych programów użytkowych, na przykład 

edytora scenariuszy. 
 
2. Ustawianie oddychania i drgawek 
− Ustawić częstość oddechów symulatora. 
− Można uruchamiać i zatrzymywać symulację różnych 

rodzajów drgawek. 
 
3. Dźwięki, drogi oddechowe i krążenie symulatora 
− Wybrać i ustawić dźwięki płuc, serca, żołądka i jelit. 
− Ustawić dźwięki wydawane głosem. (Głośność można 

sprawdzić, klikając na głośnikach wyświetlanych obok 
konfigurowanego obszaru). 

− Ustawić (włączyć lub wyłączyć) funkcję tętna (centralnego, 
promieniowego i ramieniowego). 

− Ustawienie obrzęku języka i rozdęcia żołądka. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
1. Obrzęk języka 4. Tętno ramieniowe 
2. Tętno szyjne 5. Rozdęcie żołądka 
3. Niedrożne drogi oddechowe 6. Tętno ramieniowe 
 
 
 

Uwaga: Z menu <Edit> [Edytuj] umieszczonego u góry 
ekranu można wybrać i skonfigurować dodatkowe 
dźwięki. 
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4. Kontrolowanie symulacji defibrylacji i elektrostymulacji 
serca 
− Wybór i kontrolowanie symulacji wstrząsów wymaganych do 

konwersji oraz progu elektrostymulacji. 
− Aby zastąpić rytm bieżący rytmem oczekującym, należy 

kliknąć na przycisku Running rhythm [Rytm bieżący]. 
Kliknięcie na przycisku <Extrasystole> [Skurcz dodatkowy] 
wprowadza do bieżącego rytmu dodatkowy skurcz. 

 
5. Kontrolowanie funkcji monitora instruktora 
− Monitor pokazuje stan objawów czynności życiowych 

pacjenta w trakcie symulacji. 
 
Można ustawiać kształt fali i parametry monitora pacjenta 
bezpośrednio, wybierając kursorem myszy dany kształt fali lub 
parametr numeryczny i klikając na nim. 
 
6. Okna zdarzeń (3) 
− Zawiera listy kontrolne zdarzeń istotnych dla danej symulacji. 

Zdarzenie to działanie (lub zachowanie) demonstrowane 
przez uczestnika szkolenia. 

 
7. Protokół raportów 
– Opisuje wszystkie działania wykonane w trakcie symulacji. 
 
8. Kontrolowanie trendów i programów obsługi 
− Trendy umożliwiają symulację fizjologicznych zmian 

w pewnym okresie czasu. 
− W ramce trendów instruktor może uruchamiać i zatrzymywać 

trendy. 
− Programy obsługi zdarzeń (opcja dodawana na życzenie) 

umożliwiają wywoływanie reakcji symulatora na zdarzenia. 
− W ramce programów obsługi instruktor może ukrywać trendy. 
 
9. Bieżące trendy 
− W oknie wyświetlane są bieżące trendy. Przycisk 

<Start/Stop> służy do otwarcia okna dialogowego 
kontrolowania trendów i programów obsługi (Trend and 
Handler Control) i dokonywania zmian, w którym można 
wybierać trendy i narzędzia obsługi, uruchamiać 
i zatrzymywać. 

 
10. Okno trendów 
− W oknie wyświetlany jest wykres kontrolny symulacji, który 

demonstruje w trakcie trwania symulacji przeszłe, bieżące 
i przewidywane przyszłe trendy zmian parametrów pacjenta. 

 
11. Bieżące programy obsługi 
− W oknie wyświetlane są aktualnie wykonywane programy 

obsługi. Przycisk <Hide Trends> [Ukryj trendy] służy do 
ukrywania lub przywracania ukrytych trendów 

 
12. Kontrolowanie realizacji scenariuszy 
− Uruchamianie, przerywanie lub wstrzymywanie realizacji 

scenariuszy. Ta część zawiera również przycisk raportów, 
którego wybranie powoduje zakończenie realizacji bieżącego 
scenariusza i umożliwia sporządzenie raportu. 

 
13. Kontrolowanie symulacji drgawek 
− Toniczny (2-3 sekundy) 
− Toniczny drgawkowy (1 minuta) 

Realizacja scenariusza 
− Włączyć program użytkowy instruktora kliknięciem na 

przycisku <Start>. 

− Wybrać <Start Scenario> [Rozpocznij realizację 
scenariusza]. Wyświetlona zostanie lista scenariuszy. 

− Wybrać i otworzyć scenariusz. 
− Kliknięcie na przycisku <Play> uruchamia scenariusz. 
 

Uwaga: W czasie przerwy w realizacji scenariusza 
zamiast przycisku <Pause> [Przerwij] widnieje przycisk 
<Play> [Odtwarzaj]. 

 
Przycisk <Pause/Play> jest umieszczony pod przyciskiem 
<Start Scenario> [Uruchom scenariusz]. Naciśnięcie tego 
przycisku w trakcie realizacji scenariusza przerywa sesję. 
 
Korekta parametrów pacjenta w trakcie symulacji 
Monitor pacjenta na komputerze instruktora demonstruje 
aktualny stan pacjenta. Aby ręcznie skorygować parametry 
pacjenta należy klikać na poszczególnych wykresach lub 
parametrach numerycznych. Pojawią się menu „wyskakujące“, 
za pomocą których instruktor może zmienić odnośne 
parametry, Przytrzymać kursor przez 1 sekundę nad 
parametrem numerycznym. Tło wybranego parametru zmieni 
kolor na szary, a wskaźnik myszy zmieni wygląd, sygnalizując, 
że można użyć pokrętła do zmiany wartości. 
 
Zatrzymanie sesji symulacji 
Po zakończeniu sesji symulacji należy kliknąć na przycisku 
<Stop>, pod przyciskiem <Start Scenario> [Uruchom 
scenariusz]. 
 
Protokół raportów 
W protokole sesji rejestrowane są informacje o reakcjach 
pacjenta i punktach programu uczestnika występujących 
w trakcie symulacji. Instruktor może również dodawać 
zdarzenia ręcznie. Informacje te są potem udostępniane jako 
pliki raportów po zakończeniu sesji symulacji. 
 
Aby zamieścić w raporcie komentarz na temat dokonań 
uczestnika szkolenia, należy kliknąć na przycisku <Add 
Comment> [Dodaj komentarz]. 
 
Zapisywanie plików i przeglądarka raportów 
Zapisać protokół raportów na potrzeby archiwizacji i/lub 
późniejszego wykorzystania. Przeglądarkę raportów uruchamia 
się, klikając na przycisku <Debrief> [Raporty]. Więcej informacji 
można znaleźć w punkcie „Przeglądarka raportów Laerdal“ 
niniejszej instrukcji. 
 
Monitor pacjenta 
Monitor pacjenta (wyposażenie dodatkowe) posiada dotykowy 
ekran i służy do obsługi programu użytkowego monitorowania 
pacjenta. 
 
Oprogramowanie monitora pacjenta umożliwia symulację 
prawdziwego monitora telemetrii pacjenta. 
 
Rejestracje obrazów z wyświetlacza monitora pacjenta i kamery 
sieciowej można przechowywać i przeglądać za pomocą 
przeglądarki raportów. 
 
Rejestracja wideo i przechwytywanie zrzutów ekranów do 
plików raportów są możliwe, gdy komputer monitorowania 
pacjenta jest włączony i pozostaje podłączony w trakcie 
symulacji. 
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Interfejs monitora pacjenta 
1. Menu górne 

Naciśnięcie przycisku <5wave> w menu górnym 
umożliwia przeglądanie i zmianę ustawień 
wyświetlacza monitora. 

 
Naciśnięcie przycisku umożliwia regulację 
głośności sygnału alarmowego. 

 
2. Pole odczytu parametrów 
Za pomocą tego interfejsu uczestnik może również edytować 
skalowanie, wartości graniczne alarmów itp. Kliknięcie na 
żądanym parametrze powoduje wyświetlenie menu 
zawierającego dostępne opcje. Niektóre pola są dostępne tylko 
w przypadku, gdy do manekina podłączone są odpowiednie 
czujniki. 
 
3. Menu dolne 

Na dole są dwa menu. Do przełączania 
pomiędzy menu dolnym 1 i menu dolnym 2 
służą klawisze strzałek w lewo i w prawo. 

 
Menu dolne 1 (w kolejności od lewej do prawej): 
 
Nacisnąć klawisz podwójnej strzałki w lewo, aby wyświetlić 
menu dolne 1. 

 
Przycisk <Silence Alarm> [Wyłącz alarm] 
wyłącza (OFF) dźwięki aktywnego alarmu. 
 
 
Przycisk <Pause Alarms> [Przerwij alarmy] 
wyłącza dźwięki alarmu na 3 minuty. 
 
 
 
Przycisk Cardiac Output generuje nowy odczyt 
pojemności minutowej serca. Dane szczegółowe 
dotyczące pojemności minutowej serca 
wyświetlane są w odpowiedniej części (C.O.) 
ekranu monitorowania pacjenta. 
 
Po wybraniu przycisku <Graph Trends> można 
otwierać i przeglądać wykresy trendów. 
 
 
Przycisk 12-lead ECG generuje pasek 
elektrokardiogramu z 12 odprowadzeń. Wybór 
przycisku <Print> [Drukuj] stanowi polecenie 
wydrukowania paska EKG. Polecenie zostanie 
wyświetlone w aplikacji instruktora. 

 
 
Menu dolne 2 (w kolejności od lewej do prawej): 

Nacisnąć klawisz podwójnej strzałki w prawo, aby 
wyświetlić menu dolne 2. 

 
 
Przycisk <QRS Volume> [Głośność zespołu 
komorowego] otwiera narzędzie regulacji 
głośności (0-10). 
 
Przycisk <Alarm Volume> [Głośność alarmu] 
otwiera narzędzie regulacji głośności (0-10). 
 

Przycisk <Radiology> [Radiologia] otwiera 
rentgenogramy włączone do aktualnego 
scenariusza. 
 
Przycisk <Media> otwiera okno wyświetlania 
mediów. Aby zamknąć okno wyświetlania 
mediów, należy wybrać przycisk <Close> 
[Zamknij]. 
 
Przycisk <Labs> otwiera okno wyświetlania 
wyników badań laboratoryjnych. Aby zamknąć 
okno wyświetlania wyników badań 
laboratoryjnych, należy wybrać przycisk 
<Close>. 
 
Przycisk <Main Setup> [Ustawienia główne] 
otwiera okno głównych ustawień systemu. 
Opcje w menu <Main Setup> są identyczne, jak 
odnośne opcje w wyświetlane w wierszu Menu. 
 
Przycisk <Main Screen> [Główny ekran] 
umożliwia natychmiastowy powrót do głównego 
ekranu i zamyka wszystkie menu niższego 
rzędu. 
Menu niższego rzędu można również zamknąć 
przyciskiem X w oknie menu. 

 
Pobieranie i dodawanie plików medialnych 
W trakcie sesji instruktor może udostępniać ćwiczącym pliki 
medialne. Pliki medialne obejmują rentgenogramy, materiały 
wideo i wyniki badań laboratoryjnych.  
 
Pobieranie plików medialnych 
Aby pobrać pliki medialne i udostępnić je na potrzeby sesji 
symulacyjnych, należy: 
1.  W aplikacji instruktora kliknąć na przycisku <File> [Plik]. 
2.  Kliknąć na poleceniu <Import Media Files> [Pobierz pliki 

medialne] w menu rozwijanym. Instruktor może 
wprowadzić dowolne z istniejących plików medialnych lub 
skorzystać z przeglądarki, aby wybrać własne pliki 
medialne. 

 
Dodawanie plików medialnych 
Aby dodać pliki medialne, należy: 
1.  W aplikacji instruktora kliknąć na przycisku <File> [Plik]. 
2.  Kliknąć na poleceniu <Add Media Files...> [Dodaj pliki 

medialne...] w menu rozwijanym. 
3.  Należy przejrzeć pliki i wybrać odpowiedni. 
 
Instruktor może wprowadzić dowolną liczbę plików, stosownie 
do potrzeb. 
 
Natychmiastowe wyświetlanie: 
Pliki medialne wyświetlane są niezwłocznie po ich przesłaniu. 

 
 
 
 

 
Zamawianie rentgenogramów, plików medialnych 
i wyników badań laboratoryjnych 
 
Uczestnik może zamówić rentgenogramy, pliki medialne 
i wyniki badań laboratoryjnych, klikając na którymś z odnośnych 
menu w programie użytkowym monitorowania pacjenta. 
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1.  Wywołać na ekranie menu główne. 
2.  Kliknąć na odpowiednim przycisku: Radiology, Media, lub 

Labs. 
3.  W oknie dialogowym wybrać <Order New> [Zamów 

nowy]. 
4.  System powiadomi instruktora o zamówieniu za 

pośrednictwem aplikacji instruktora. 
 
Uczestnik szkolenia może również kliknąć na którymś 
z odnośnych menu, aby sprawdzić, czy instruktor zapewnił 
możliwość przeglądania któregoś z plików medialnych. 
 
Przeglądarka raportów Laerdal 
Przeglądarka raportów to narzędzie umożliwiające otwieranie 
i przeglądanie zapisanych w pamięci sesji symulacyjnych. Plik 
raportu zawiera niżej wymienione informacje zarejestrowane 
w trakcie symulacji: 
 
•  Protokół sesji 

W trakcie sesji symulacji dane i punkty programu są 
rejestrowane są i opatrywane znacznikiem czasu. 
Uwzględniane są uwagi instruktora. 
 

•  Monitor pacjenta 
Wyświetlane obrazy monitora pacjenta można zarejestrować 
jako plik wideo. 
 

•  Kamera sieciowa 
Sygnały wideo z kamery sieciowej podłączonej do komputera 
instruktora lub do komputera monitora pacjenta. 
 

•  Wejścia mikrofonowe 
Rejestrowane są zapisy głosu i dźwięku z mikrofonu kamery 
sieciowej. 
 

•  Komentarze dodawane w trakcie przeglądu 
W trakcie przeglądania raportu w przeglądarce (<Debrief 
Viewer>) można dodawać do protokołu z sesji (<Session 
Log>) komentarze i edytować je. 

 
Uwaga: Wszystkie źródła są rejestrowane według tej 
samej skali czasowej i zawsze są odtwarzane 
równocześnie. 

 
Włączanie przeglądarki raportów 
Przeglądarkę raportów Laerdal można uruchomić na dwa 
sposoby: 
 
1 - Z poziomu aplikacji instruktora: 
•  Kliknąć na przycisku Stop <       >. 

Przycisk Stop znajduje się pod wyświetleniem czasu. 
 

•  Kliknąć na przycisku <Debrief> [Raport] w oknie dialogowym 
<Start Scenario> [Rozpocznij scenariusz]. 

 
•  Pliki raportów z sesji zostaną przesłane i udostępnione 

w przeglądarce raportów Laerdal (<Laerdal Debrief 
Viewer>). 

 
Uwaga: Należy pamiętać o zapisaniu w pamięci plików 
raportów, aby umożliwić ich późniejsze przeglądanie. 
 

2 - Z menu Start programu Windows: 
•  Kliknąć na przycisku <Start> sytemu Windows. 
 
•  Wybrać <All Programs> [Wszystkie programy]. 
 

•  Wybrać folder programu <Laerdal Debrief Viewer> 
[Przeglądarka raportów Laerdal]. 

 
•  Wybrać <Laerdal Debrief Viewer> [Przeglądarka raportów 

Laerdal]. 
 
System wyświetla okno przeglądania raportów dla danej sesji. 
 
Zaawansowany System Video Laerdal 
(Advanced Video System, AVS) 
 

Zainstalowanie zaawansowanego systemu video Laerdal 
(wyposażenie dodatkowe) umożliwia dokonywanie w trakcie 
sesji symulacyjnych wysokiej jakości wideorejestracji z użyciem 
maksymalnie 4 kamer wideo i przeglądanie ich w przeglądarce 
raportów. 
 

Uwaga: Zaawansowany System Video Laerdal nie 
wchodzi w skład zestawu SimJunior, ale można go 
zakupić u lokalnego przedstawiciela lub dystrybutora 
firmy Laerdal. 

 
Dostosowanie scenariuszy do potrzeb 
użytkownika 
 
Scenariusze SimJunior można tworzyć i edytować za pomocą 
zestawu edytorów: 
•  Edytor scenariuszy 
•  Edytor trendów 
•  Edytor programu obsługi zdarzeń 
 
Układ ekranu monitora pacjenta można dostosować do potrzeb 
użytkownika za pomocą edytora scenariuszy. Z menu <Edit> 
[Edytuj] wybrać <Edit Monitor layout...> [Edytuj układ 
monitora...]. 
 
Elementarne zdarzenia uczestnika można dostosować do 
potrzeb szkolenia za pośrednictwem scenariusza i edytora 
programów obsługi zdarzeń. 
 
1.  Wybrać menu <Edit> [Edytuj] (usytuowane u góry ekranu 

aplikacji instruktora). 
2.  W menu rozwijanym wybrać <Scenario Editor> [Edytor 

scenariuszy]. 
3.  Otwarte zostanie okno nowego scenariusza (SimJunior). 

Z menu u góry okna wybrać <Edit> [Edytuj]. 
4.  Z menu rozwijanego wybrać <Edit Event Menus> [Edytuj 

zdarzenia menu]. 
 
Dostęp do wszystkich edytorów SimJunior można uzyskać, 
korzystając z menu <Edit> [Edytuj] z programu użytkowego 
instruktora lub, bezpośrednio, poprzez menu <Start> programu 
Windows: 
 
1.  Kliknąć na przycisku <Start> sytemu Windows. 
2.  Wybrać <Programs> [Programy]. 
3.  Wybrać <SimJunior Instructor Application> [Program 

użytkowy instruktora]. 
     Pojawi się następująca lista: 

Edytor scenariuszy 
Plik pomocy SimJunior 
Program użytkowy instruktora SimJunior 
Aktualizacja programu SimJunior 
Edytor trendów 

 
4. Wybrać edytor. 
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Edytor scenariuszy 
Edytor scenariuszy umożliwia definiowanie relacji między 
punktami programu uczestnika i reakcjami pacjenta metodą 
rysowania linii za pomocą prostego edytora graficznego. 
 
Trendy 
Trendy są zestawami parametrów fizjologicznych, których 
wzrost lub spadek w przedziale czasowym można wcześniej 
zaprogramować. 
 
Programy obsługi 
Programy obsługi to wstępnie zaprogramowane zestawy 
zdarzeń powiązane z czynnościami. 
 
Wyłączenie wewnętrznej sprężarki 
Jeśli używana jest zewnętrzna sprężarka, należy wyłączyć 
sprężarkę wewnętrzną, odznaczając kratkę obok opcji 
<Integrated Compressor Enabled> [Wbudowana sprężarka 
aktywna] na polu stanu pacjenta. 
 
 
 
       Wbudowana sprężarka aktywna 
 
 
Zmiana ustawień w trakcie symulacji 
W trakcie symulacji można regulować ustawienia 
wewnętrznego kompresora, obrzęku języka i drgawek. Służy do 
tego menu dialogowe SimJunior. Zmiany wprowadzone w tym 
oknie nie mają wpływu na ustawienia standardowe manekina. 
1.  W aplikacji instruktora kliknąć na przycisku <Edit> 

w pasku menu programu. 
2.  Z menu rozwijanego wybrać <Start SimJunior Dialog> 

[Włączyć okno dialogowe SimJunior]. 
3.  Wprowadzić wymagane wartości. 
4.  Kliknąć na przycisku <Apply> [Zastosuj]. 
 
 
 
 
 
 
 
 
 
 

Uwaga: Sprężarkę można ustawić jedynie w przedziale 
30-50%. Ustawienie sprężarki na 30% ogranicza do 
minimum wewnętrzny szum i pozwala lepiej symulować 
płytki oddech.  Nasilenie oddechu jest maksymalne przy 
sprężarce ustawionej na 50%. 

 
Zmiana ustawień standardowych 

Uwaga: Po zapisaniu w pamięci nowych ustawień 
domyślnych, nowe parametry będą parametrami 
wyjściowymi przyszłych symulacji. 

 
Sprężarka wewnętrzna 
Można skonfigurować ustawienie szybkości obrotowej (RPM) 
sprężarki wewnętrznej. Z poziomu programu użytkowego 
instruktora: 
 

1.  W menu programu użytkowego instruktora wybrać <Edit> 
[Edytuj]. 

2.  Z menu rozwijanego wybrać <Configuration> 
[Konfiguracja]. 

3.  Konfiguracja – wyświetlone zostanie okno ustawień 
domyślnych programu. Z pozycji <Target Values> 
[Wartości docelowe] wybrać opcję <Compressor RPM> 
[Prędkość obrotowa sprężarki] 

 
Obrzęk języka 
Z poziomu programu użytkowego instruktora: 
1.  W menu programu użytkowego instruktora wybrać <Edit> 

[Edytuj]. 
2.  Z menu rozwijanego wybrać <Configuration> 

[Konfiguracja]. 
3.  Konfiguracja – wyświetlone zostanie okno ustawień 

domyślnych programu. Wybrać opcję <Tongue edema 
pressure> [Ciśnienie obrzęku języka]. 

 
Napad 
Z poziomu programu użytkowego instruktora: 
1.  W menu programu użytkowego instruktora wybrać <Edit> 

[Edytuj]. 
2.  Z menu rozwijanego wybrać <Configuration> 

[Konfiguracja]. 
3.  Konfiguracja – wyświetlone zostanie okno ustawień 

domyślnych programu. Wybrać opcję <Seizure intensity> 
[Intensywność napadu]. 

 
 
 
 
 
 
 
 
 
 
 
 
Pliki z informacjami pomocniczymi 
Pliki z informacjami pomocniczymi można włączyć 
w następujący sposób: 
1.  Kliknąć na przycisku <Start> sytemu Windows. 
2.  Wybrać <Programs> [Programy]. 
3.  Wybrać <SimJunior Instructor Application> [Program 

użytkowy instruktora]. 
4.  Wybrać <SimJunior Help File> [Plik pomocy SimJunior]. 
 



Konfiguracja manekina 
 

 22 

Przygotowanie do symulacji 
Po przygotowaniu manekina SimJunior oraz skonfigurowaniu 
i przygotowaniu wszystkich stosownych urządzeń 
interaktywnych (pilota lub komputera instruktora oraz monitora 
pacjenta) konieczne może okazać się wykonanie końcowych 
zabiegów przygotowawczych, poprzedzających przystąpienie 
do symulacji. 
 
W ramach końcowego przygotowania do symulacji należy 
wykonać następujące czynności: 
•  Zmiana ustawień sprężarki wewnętrznej 
•  Podłączenie sprężarki zewnętrznej 
•  Przygotowanie nogi z dostępem dożylnym 
•  Podawanie dożylne płynów 
•  Odsączanie nadmiaru płynu dożylnego 
•  Czyszczenie ręki podawania dożylnego 
•  Instalowanie nasadek defibrylacyjnych 
•  Podłączanie mankietu do pomiaru ciśnienia krwi 
•  Wymiana źrenic 
 
Korzystanie ze sprężarki zewnętrznej 
Sprężarkę zewnętrzną należy podłączyć do przeźroczystej rurki 
wychodzącej wraz z wiązką kabli z prawego boku manekina. 
 
Więcej informacji na temat zewnętrznych sprężarek i paneli 
regulatorów kompatybilnych z systemem SimJunior można 
uzyskać u lokalnego przedstawiciela firmy Laerdal. 
 
Przygotowanie nogi z dostępem 
śródkostnym 
 
Prawa noga manekina służy do ćwiczenia umiejętności 
wykonywania wlewów śródkostnych. Elementy anatomiczne 
prawej nogi obejmują kolano, piszczel, okolicę guzowatości 
piszczeli i okolicę kostki przyśrodkowej. Do prawej nogi 
dołączona jest rurka dostępu dożylnego i worek dostępu 
służący za zbiornik w trakcie symulacji infuzji. 
 
Niezbędne dodatkowe wyposażenie: 
•  Worek wlewu dożylnego i zestaw do podawania leków. 
•  Koncentrat płynu imitującego krew. 
•  Strzykawka o pojemności 35 cm3 i igła śródkostna 

w rozmiarze 16. 
 
Aby napełnić nogę z dostępem śródkostnym i przygotować ją 
do użyci należy: 
1.  Unieść nogę do pozycji pionowej. 
 
 

2.  Otworzyć zatyczkę na pięcie. 
3.  Wlać strzykawką do kości ok. 240-250 cm3 płyn imitujący 

krew. 
4.  Przymocować rurę prowadzącą do worka wlewu 

dożylnego. (Do zamykania lub otwierania przewodu należy 
użyć w razie potrzeby zacisku rolkowego, aby zwolnić 
zmniejszyć powstałe ciśnienie.) 

5.  Zamknąć rurkę prowadzącą do worka, aby płyn imitujący 
krew pozostał w kości. 

6.  Po napełnieniu worka należy przerwać wlewanie 
i wymienić worek. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Przed odłożeniem manekina na miejsce przechowywania 
należy: 
− Odłączyć przewód wlewu i zbiornik od złączki w stopie. 
− Umożliwić całkowity odpływ cieczy. 
− Nie zamykać otworu w stopie zatyczką, aby umożliwić 

odparowanie płynu. 
 

Uwaga: Nie używać roztworu soli; może niekorzystnie 
wpłynąć na stan nogi. Aby zapobiec odkładaniu się 
osadu, należy używać wody destylowanej lub 
dejonizowanej. 

 
Podawanie dożylne płynów 
Prawa ręka umożliwia szkolenie w zakresie podawania leków, 
wprowadzania cewnika, wlewów i podawania leków w bolusie 
do żył obwodowych w przedramieniu, zgięciu łokciowym i na 
grzbiecie dłoni. 
 
Do symulacji dostępu dożylnego używać igły w rozmiarze 20-
22. Aby zapobiec zatkaniu się układu dostępu dożylnego, do 
symulacji leków dożylnych używać wyłącznie wody 
destylowanej lub dejonizowanej. 
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Odsączanie nadmiaru płynu dożylnego 
Układ płynów dożylnych jest układem otwartym. Płyny dożylne 
są odprowadzane w miarę podawania. 
 
Przed każdą sesją: 

1.  Przymocować rurkę przelewową dostępu dożylnego 
(w prawej ręce manekina) do pojemnika przelewowego 
(np. worka wlewu dożylnego). 

2.  W trakcie symulacji należy umożliwić odpływ nadmiaru 
płynu do pojemnika. 

 
Czyszczenie ręki z dostępem dożylnym 
Po każdej sesji lub po zakończeniu korzystania z manekina 
w danym dniu należy przepłukać rękę z dostępem dożylnym 
60-procentowym roztworem alkoholu izopropylowego lub 70-
procentowym roztworem etanolu. 
 
Instalowanie nasadek defibrylacyjnych 
Tors manekina posiada dwa złącza kołkowe do przewodów 
defibrylatora. Przed przystąpieniem do defibrylacji należy 
odkręcić i zdjąć osłony złączy defibrylacyjnych. 
 
 
 
 
 
 
 
 
 
 
 
 
W opakowaniu z manekinem znajdują się dwie nasadki 
defibrylacyjne. Przed użyciem defibrylatora pod napięciem 
z elektrodami defibrylacyjnymi lub wkładkami przylepnymi 
nasadki defibrylacyjne muszą być zamontowane. Przykręcić 
nasadki defibrylacyjne. 
 
 
 
 
 
 
 
 
 
 
 
W trakcie defibrylacji 
Z manekinem SimJunior można używać konwencjonalnego 
defibrylatora (niewchodzącego w zakres dostawy). W trakcie 
defibrylacji zarówno defibrylator, jak i manekin mogą stanowić 
źródło zagrożenia porażeniem elektrycznym. Używając 
defibrylatora do zabiegów na manekinie należy zachować 
wszelkie standardowe środki ostrożności. 

 
Uwaga! W trakcie defibrylacji manekin nie może 
pozostawać w kontakcie z powierzchnią lub 
przedmiotami przewodzącymi elektryczność. 

Ostrzeżenia: 
− Zabieg defibrylacji należy wykonywać wyłącznie na złączach 

defibrylacyjnych. 
− Nie wolno naciskać zbyt mocno na złącza defibrylacyjne, 

gdyż może to spowodować wyładowanie łukowe i. w efekcie, 
skazy punktowe. 

− Nie wolno defibrylować manekina bez nałożonej na tors 
skóry. 

 
Podłączanie mankietu do pomiaru 
ciśnienia krwi 
 
Manekin jest dostarczany wraz ze specjalnie dostosowanym 
mankietem do pomiaru ciśnienia krwi. 
Przed użyciem należy podłączyć rurkę do białej złączki 
ciśnienia krwi z tyłu jednostki sterowniczej VitalSim. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Uwaga: Głośnik symulacji ciśnienia krwi w manekinie 
znajduje się w lewym dole przedłokciowym, 
zaznaczonym kółkiem na poniższej ilustracji. Tętna 
promieniowe i ramieniowe można badać w miejscach 
zaznaczonych prostokątami. 

 
 
 
 
 
 
 
 
 
Kalibracja mankietu do pomiaru ciśnienia krwi 
z użyciem komputera instruktora 
 
1.  Z rozwijanego menu wybrać <Calibration> [Kalibracja]. 
2.  Z menu rozwijanego wybrać <Calibrate BP...> [Kalibruj 

ciśnienie krwi...]. 
3.  Wykonać kalibrację zgodnie ze wskazówkami 

wyświetlanymi na ekranie. 
 
Kalibracja mankietu do pomiaru ciśnienia krwi 
z użyciem pilota 
 
Aby skalibrować mankiet do pomiaru ciśnienia krwi z użyciem 
pilota standardowego systemu SimJunior, należy: 
1.  Wywołać menu ustawiania parametrów (Setup Menu). 
2.  Wybrać <Calibrate BP> [Kalibruj ciśnienie krwi]. 
3.  Wykonać czynności zgodnie ze wskazówkami 

wyświetlanymi na ekranie. 
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Wymiana źrenic 
W głowie dostarczonego manekina SimJunior zainstalowane są 
prawidłowe źrenice. Z symulatorem SimJunior dostarczany jest 
osobny zestaw zawierający plastikowe wkładki źrenic 
(zwężonych i rozszerzonych). 
 
Wymiana źrenic: 

1.  Otworzyć szeroko powieki manekina. Uważać, aby nie 
rozerwać skóry twarzy. 

2.  Ostrożnie wyjąć źrenicę z oka. Użyć do tego celu ssawki 
dostarczonej w zestawie lub ostrożnie podważyć źrenicę 
paznokciem. 

3.  Włożyć wybraną wkładkę źrenicy, używając przyssawki 
lub delikatnie wcisnąć wkładkę palcem. 
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Konserwacja po każdej sesji symulacji 
Aby zapewnić długi okres użytkowania manekina 
SimJunior, wymagane jest stosowanie podanych niżej 
środków zapobiegawczych. 
− Przywrócić manekin i komputer do pierwotnego stanu. 
− Wyłączyć zasilanie jednostki sterującej i komputera. 
− Doładowywać w miarę potrzeby akumulatorki. 
− Przepłukać układ rurek ręki z dostępem dożylnym 

i opróżnić nogę z dostępem śródkostnym (nie zamykać 
otworu w stopie nogi z dostępem śródkostnym). 

− Po każdej sesji z użyciem ręki z dostępem dożylnym 
należy przepłukać rękę 60-procentowym roztworem 
alkoholu izopropylowego lub 70-procentowym roztworem 
etanolu. 

− Wytrzeć skórę wilgotną ściereczką. 
− Zdjąć wilgotną odzież lub bieliznę. 
− Wilgotną ściereczką lub wacikiem nasączonym spirytusem 

zetrzeć ślady taśmy. 
− W zależności od sposobu, w jaki korzystano z manekina, 

należy wymienić zużyte lub uszkodzone moduły. 
− Wymienić przewody lub złącza z widocznymi 

uszkodzeniami. 
− W regularnych odstępach czasu wykwalifikowani 

pracownicy powinni wykonywać obsługę techniczną 
manekina. 

− Czynności serwisowe należy koniecznie wykonać: 
− W razie rozlania płynów wewnątrz lub na powierzchni 

manekina. 
− Po użyciu manekina w warunkach zapylenia. 
 

Informacje na temat części zamiennych zawiera 
punkt: Części zamienne i akcesoria 

 
Przed magazynowaniem lub wysyłką 
− Przepłukać rękę z dostępem dożylnym i układy płynów 60-

procentowym alkoholem izopropylowym lub 70-
procentowym etanolem. Otworzyć zawór spustowy na 
spodzie prawej stopy manekina. 

 
Instalowanie i aktualizacja 
oprogramowania SimJunior. 
 
System SimJunior dostarczany jest z zainstalowanym 
oprogramowaniem. Jeśli konieczne jest ponowne 
zainstalowanie lub aktualizacja oprogramowania, należy 
wykonać następujące czynności. 
1.  Włączyć zasilanie komputera. Żadna z aplikacji systemu 

SimJunior nie powinna być włączona. 
2.  Odinstalować wszystkie poprzednie wersje 

oprogramowania SimJunior. Włączyć funkcję 
dodawania/usuwania programów dostępną w Panelu 
sterowania programu Windows. 

3.  Wybrać SimJunior i polecenie <Uninstall> [Odinstaluj]. 
4.  Włożyć płytkę DVD z oprogramowaniem Laerdal 

SimJunior. Program włączy się automatycznie. Jeśli 
opcja uruchamiania automatycznego w komputerze jest 
wyłączona, uruchomić ręcznie plik <autorun.exe> 
Odinstalowanie programu należy przeprowadzać 
zgodnie ze wskazówkami wyświetlanymi na ekranie. 

5.  W menu instalacyjnym - kliknąć jeden raz na przycisku 
<Install SimJunior Software complete> [Zainstaluj 
kompletne oprogramowanie SimJunior]. Uruchomi to 
proces kopiowania plików na komputer użytkownika. 

 
Uwaga: Proces pobierania trwa ok. 2-3 minut. Po 
zakończeniu procesu kopiowania należy 

przeprowadzić instalację zgodnie ze wskazówkami 
kreatora instalacji. 

 
Aktualizacja oprogramowania SimJunior 
(aktualizacja oprogramowania VitalSim): 

 
Uwaga! W trakcie opisanej niżej procedury zasilanie 
jednostki sterującej VitalSim musi być włączone. 
 
Uwaga: Wersja oprogramowania podana na zrzutach 
ekranu może być w rzeczywistości inna. 
 

1.  Upewnić się, czy oprogramowanie zostało 
zainstalowane na komputerze instruktora w sposób 
wyżej opisany. Instalowanie i aktualizacja 
oprogramowania SimJunior“. 

2.  Włączyć zasilanie jednostki sterującej VitalSim. Nie 
uruchamiać aplikacji instruktora, ani aplikacji 
monitorowania pacjenta.  

3.  Podłączyć kabel USB do jednostki sterującej VitalSim 
i komputera instruktora. 

4.  Przejść do <Start> <All Programs> [Wszystkie 
programy]. 

5.  Wybrać <SimJunior Instructor Application> [Program 
użytkowy instruktora SimJunior], <SimJunior Program 
Update> [Aktualizacja programu SimJunior]. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
6.  Z menu rozwijanego aktualizacji wybrać urządzenia, 

które mają być aktualizowane. 
7.  Aplikacja aktualizacji programu SimJunior rozpocznie 

identyfikowanie aktualnie zainstalowanej wersji 
oprogramowania. 

8.  Wyświetlona zostanie lista wszystkich programów. Stan 
aktualizacji każdego z programów wyświetlany jest pod 
polem <Update> [Aktualizuj]. 

9.  Kliknąć <OK>, aby rozpocząć aktualizację 
oprogramowania. 

10. Zaktualizować program z poleceniami kreatora 
aktualizacji. 

 
Raport menedżera aktualizacji SimJunior wyświetla 
wszystkie aktualizacje. W raporcie oznaczone są również 
aktualizacje pomyślnie wykonane i zakończone 
niepowodzeniem. 
 
1.  Jeśli w trakcie aktualizacji na ekranie pojawi się 

komunikat o błędzie, należy kontynuować proces 
instalowania aktualizacji (kliknąć na polu <Yes>). 

2.  W razie niepowodzenia aktualizacji modułu należy 
ponowić próbę. Jeśli kilkakrotnie nie powiedzie się 
aktualizacja któregoś z modułów, należy sprawdzić, czy 
wszystkie wewnętrzne przewody są podłączone 
i działają prawidłowo. 
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Otwarcie torsu 
Tors manekina należy otworzyć w celu wykonania takich 
zabiegów, jak: 
− Mocowanie lub wymiana kończyn 
− Wymiana akumulatorków manekina 
− Wymiana dętki unoszenia klatki piersiowej i mieszków płuc 
− Wymiana skóry torsu 
− Ogólna kontrola 
 

Ostrzeżenie: Tors należy otwierać od lewej do 
prawej, odczepiając ostrożnie skórę z zaczepów. Nie 
ciągnąć zbyt mocno skóry manekina przy unoszeniu, 
aby nie uszkodzić kabli klatki piersiowej. 
 

1.  Odczepić mocowania skóry z lewej strony torsu i na obu 
ramionach. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2.  Odwinąć skórę torsu na prawo. 
3.  Odłączyć kabel złącza defibrylacji. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
4.  Kabel złącza defibrylacji należy odłączyć z prawej 

strony manekina, poniżej uformowania klatki piersiowej. 
 

Uwaga: NIE WOLNO odłączać rurek i przewodów 
łączących wkładkę piankową żołądka z manekinem. 
 

5.  Nałożyć z powrotem skórę, wykonując czynności 1- 4 
w odwrotnej kolejności. 

Wymiana akumulatorka manekina 
1.  Otworzyć tors manekina. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2.  Wysunąć akumulatorek z paska mocującego. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3.  Wyciągnąć złącze zasilania z manekina. Odczepić 

złącze zasilania od akumulatorka. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
4.  Wyjąć akumulatorek z manekina. 
5.  Włożyć naładowany akumulatorek lub zainstalować 

nowy, dopuszczony przez producenta do użytku 
z symulatorem SimJunior. 

6.  Podłączyć akumulatorka do manekina 
7.  Nałożyć skórę torsu. 
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Ładowanie akumulatorka manekina 
Akumulatorek manekina ładuje się samoczynnie w trakcie 
pracy. W razie potrzeby można go doładować, używając 
zewnętrznej ładowarki (wyposażenie dodatkowe). 
1.  Wyłączyć zasilanie manekina za pomocą jednostki 

sterującej VitalSim. 
2.  Wyjąć akumulatorek z manekina. 
3.  Przyłączyć zewnętrzną ładowarkę zatwierdzoną do 

użytku z manekinem (z przewodem sieciowym 
odpowiadającym lokalnym wymaganiom) do gniazdka 
na spodzie akumulatorka. Podłączyć przewód sieciowy 
ładowarki do gniazdka w ścianie. 

 
 
 
 
 
 
 
 
 
 
 
 
 
4.  Po zakończeniu ładowania włożyć akumulatorek 

z powrotem do manekina. 
 
 
 
Wymiana mieszka unoszenia klatki 
piersiowej 
Mieszek unoszenia klatki piersiowej jest umieszczony 
w dolnej części jej płyty, na środku, pod płucami. 
 
1.  Odwinąć skórę torsu osłaniającą płytę klatki piersiowej 

(zob. punkt Ustawienia). Otwarcie torsu 
2.  Odłączyć przeźroczystą rurkę od mieszka płuc i wyjąć 

mieszek. Wyjęcie mieszka płuc – zob. punkt: Wymiana 
mieszka płuc. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3.  Odłączyć przeźroczystą rurkę od mieszka unoszenia 

klatki piersiowej. 
4.  Wyrzucić zużyty mieszek. 
5.  Włożyć nowy mieszek. 
6.  Podłączyć rurkę do nowego mieszka. 
7.  Zamknąć tors i nałożyć z powrotem skórę torsu. 
 
 
 
Wymiana mieszka płuc 
Jeśli pojawi się wyciek, należy wymienić mieszek płuc (w 
jamie klatki piersiowej). 
 
 
 
 
 
 
 
 
 
 
 
 
1.  Odczepić skórę torsu. 
2.  Odłączyć przeźroczystą rurkę z obu stron mieszka płuc 

– zob. ilustracja w punkcie 2: „Wymiana mieszka 
unoszenia klatki piersiowej“. 

3.  Odłączyć zacisk mieszka płuc od górnej środkowej 
części mieszka. 

 
 
 
 
 
 
 
 
 
 
 
 
4.  Ostrożnie wyjąć górną środkową część mieszka płuc 

z gniazdka. 
5.  Zainstalować nowy mieszek, wykonując powyższe 

czynności w odwrotnej kolejności. 
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Wymiana skóry manekina 
Skóra manekina może wymagać wymiany, jeśli jest rozdarta, 
przedziurawiona lub poplamiona. 
 
Skóra torsu: 
Opis wymiany skóry torsu zawiera punkt „Otwarcie torsu“ 
 
Skóra ręki: 
Aby wymienić skórę ręki manekina, należy: 

1.  Zdjąć starą skórę z ręki manekina, ściągając ją z ręki i 
dłoni lub odcinając*. 

 
Ostrzeżenie: *Uważać, aby nie przedziurawić, ani 
nie przeciąć trzonu ręki. 
 

2.  Wyrzucić zużytą skórę. 
3.  Zwilżyć wewnętrzną stronę nowej skóry ręki wodnym 

roztworem łagodnego środka czyszczącego w płynie. 
4.  Zwilżyć (lub namydlić) trzon wodnym roztworem 

łagodnego mydła w płynie. 
5.  Wsunąć dłoń manekina w skórę. 
6.  Nasunąć skórę na palce (jak rękawiczkę). 
7.  Naciągnąć skórę ręki na trzon. 
 
 
 
 
 
 
 
Wymiana prawej ręki z dostępem 
dożylnym 
 
Opis wymiany skóry torsu zawiera punkt „Otwarcie torsu“. 

1.  Wymontować starą rękę, odkręcając sworzeń mocujący 
rękę do ramienia manekina. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2.  Śruba ramienia powinna być dostatecznie poluzowana, 

aby umożliwić łatwe wysunięcie osi ręki. 
3.  Usunąć starą rękę zgodnie z określonymi wytycznymi. 
 

Zamocowanie nowej ręki: 
 
 
 
 
 
 
 
 
 
 
 
1.  Śruba ramienia powinna być dokręcona na tyle luźno, 

aby umożliwić łatwe wsunięcie osi ręki. 
2.  Podłączyć przewody ręki do odpowiednich złączy 

w torsie. 
3.  Ostrożnie włożyć oś ręki do końca we wspornik 

ramienia i wsunąć do końca. 
4.  Kluczem z gniazdkiem sześciokątnym dokręcić śrubę 

ramienia. 
 
Wymiana prawej nogi z dostępem 
śródkostnym 
 
Aby odłączyć prawą nogę, należy: 

1.  Sprawdzić, czy w nodze nie pozostał nieodsączony 
płyn. 

2.  Wymontować starą nogę z dostępem śródkostnym, 
odkręcając sworzeń mocujący ją do uda. 

3.  Wysunąć dolną część nogi z uda. 
4.  Usunąć starą nogę zgodnie z określonymi wytycznymi. 
 
Zamocować nową nogę z dostępem śródkostnym, 
wykonując powyższe czynności w odwrotnej kolejności. 
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Ustawienia systemu 
Problem 
•  Utrata danych lub całkowita awaria systemu (Ogólna awaria 

systemu). 
 
Możliwe rozwiązanie 
•  W przypadku całkowitego wyłączenia systemu lub utraty 

danych prosimy o kontakt z lokalnym Centrum Serwisowym 
firmy Laerdal. 

 
Przeglądarka raportów 
Problem 
•  Brak obrazu wideo - kamera sieciowa nie rejestruje obrazu 

wideo na potrzeby raportów. 
 
Możliwe rozwiązania 
• Sprawdzić, czy kabel USB kamery sieciowej jest podłączony 

do koncentratora USB. 
•  Sprawdzić w edytorze profili ustawienia kamery sieciowej. 

Ustawienia powinny być zgodne z konfiguracją kamery. 
•  Upewnić się, czy używany jest właściwy plik profilu. 
• Tylko jedna kamera sieciowa USB powinna być przyłączona 

do komputera. 
• Wideorejestracje są przechowywane na komputerze 

podłączonym do kamery sieciowej. Sprawdzić, czy komputer, 
do którego przyłączona jest kamera sieciowa jest dostępny w 
momencie przesyłania plików do raportu. 

 
Problem 
•  Rejestracje wideo z monitora pacjenta nie są dołączone do 

raportów. 
 
Możliwe rozwiązania 
•  Sprawdzić, czy używana nazwa komputera monitorowania 

pacjenta jest zgodna z ustawieniami używanego profilu. 
•  Z menu głównego programu użytkowego instruktora wybrać 

<Edit> [Edytuj]. Wybrać konfigurację wideorejestracji. 
Sprawdzić, czy zaznaczono opcję „Use web camera“ [Użyj 
kamery sieciowej]. 

 
 
Manekin 
Problem 
•  Nieprzewidywalne zachowanie. 
 
Możliwe rozwiązania 
• Nieprawidłowości w działaniu manekina mogą być 

spowodowane poluzowaniem przewodów, rurek lub złączy. 
Otworzyć tors i sprawdzić, czy któraś część nie jest 
odłączona i czy nie ma wycieków. Dodatkowe wskazówki 
zawiera punkt: Przygotowanie manekina - Otwarcie torsu. 

•  W razie wycieku płynu wyłączyć zasilanie manekina 
i skontaktować się z serwisem technicznym firmy Laerdal. 

Zanieczyszczenie dróg oddechowych 
Problem 
• Drogi oddechowe manekina zostały zanieczyszczone 

wskutek zabiegu sztucznego oddychania usta-usta. 
 
Możliwe rozwiązanie 
•  Oczyścić zewnętrzną powierzchnię manekina ściereczkami 

do czyszczenia manekina. Oczyścić wnętrze jamy ustnej 
ściereczkami do czyszczenia manekina. Wymienić mieszek 
płuc – zob. punkt: Konserwacja - Wymiana mieszka płuc. 

 
Ruchy klatki piersiowej 
Problem 
•  Klatka piersiowa manekina nie unosi się. 
 
Możliwe rozwiązania 
•  Sprawdzić, czy zasilanie manekina jest włączone  
•  Sprawdzić, czy parametr awRR nie został ustawiony na zero 

w programie użytkowym instruktora (przypadek chorobowy 
lub scenariusz). 

• Sprawdzić, czy wybrano rytm sercowy perfuzyjny manekina. 
• Sprawdzić, czy nie ustawiono komplikacji dróg 

oddechowych, np. maksymalnego oporu płuc lub kurczu 
krtani. 

• Sprawdzić, czy na ekranie programu użytkowego instruktora 
zaznaczono kratkę przy opcji Integrated Compressor 
Enabled [Wbudowana sprężarka aktywna]. Dodatkowe 
wskazówki zawiera punkt: Wyłączenie wewnętrznej sprężarki 

•  Sprawdzić, czy zewnętrzne źródło sprężonego powietrza jest 
wyłączone i czy rurka powietrza jest odłączona od manekina. 

•  Wewnętrzna sprężarka może być przegrzana. Odczekać ok. 
20 minut na schłodzenie sprężarki. 

• Unoszenie klatki piersiowej ustawiono na unoszenie 
obustronne (na przykład rurka dotchawicza jest włożona zbyt 
głęboko w oskrzela). 

• Mieszek unoszenia klatki piersiowej jest nieszczelny, 
względnie rurka mieszka jest skręcona, zagięta lub 
odłączona. Wymienić mieszek unoszenia klatki piersiowej, 
jeśli jest nieszczelny – zob. punkt Konserwacja: Wymiana 
mieszka unoszenia klatki piersiowej. 

•  Sprawdzić, czy rurka powietrza jest szczelna; sprawdzić, czy 
wszystkie połączenia są nieuszkodzone. Wymienić odcinek 
rurki, jeśli jest nieszczelna. 

•  Stale mają miejsce płytkie ruchy klatki piersiowej, 
a wewnętrzna sprężarka pracuje nieprzerwanie. Wewnętrzna 
sprężarka może być wyeksploatowana. Skontaktować się 
z Serwisem Technicznym firmy Laerdal. 

 
Płuca 
Problem 
•  Płuca nie działają prawidłowo 
 
Możliwe rozwiązania 
•  Otworzyć tors i płytkę klatki piersiowej. Sprawdzić, czy płuca 

mogą się swobodnie rozszerzać i czy nie są blokowane 
przez przewody. 

•  Sprawdzić, czy mieszki płuc są prawidłowo podłączone, 
a rurki nie są skręcone. 

• Sprawdzić, czy mieszek płuc jest ułożona poziomo 
i prawidłowo włożony. 

• Sprawdzić, czy mieszki płuc nie są uszkodzone lub 
rozerwane. 
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•  Sprawdzić, czy wewnątrz dróg oddechowych manekina nie 
ma przedmiotów, które mogą blokować przepływ powietrza. 

•  Jeśli regulacja podatności płuca nie spowoduje żadnych 
zmian, skontaktować się z Serwisem Technicznym firmy 
Laerdal. 

• Jeśli opór płuca nie zmieni się, skontaktować się z Serwisem 
Technicznym firmy Laerdal 

 
Hałas mechaniczny w trakcie osłuchiwania 
 
W programie użytkowym instruktora kliknąć na polu 
<Auscultation focus> [Ognisko auskultacji]. 
 
Tętna (promieniowe i ramieniowe) 
Problem 
•  Nie można wyczuć tętna 
 
Możliwe rozwiązania 
•  Skóra może być zbyt napięta nad zespołami tętna - należy 

ponownie nałożyć skórę i zresetować manekin. 
•  Sprawdzić, czy ciśnienie skurczowe krwi jest ustawione na 

minimum 60. 
•  Sprawdzić, czy sprężarka jest włączona 
 

Uwaga: Jeśli tętno promieniowe jest ustawione na 
mniej niż 60, tętna obwodowe mogą zaniknąć. 

 
Wyłączenie manekina 
Problem 
•  Manekin nie reaguje. 
 
Rozwiązanie 
1.  Wyłączyć zasilanie jednostki sterującej VitalSim. 
2.  Wyłączyć pilota. 
3.  Wyłączyć oprogramowanie SimJunior na komputerze 

instruktora i monitorze pacjenta. 
4.  Ponownie uruchomić cały system. 
 
Jeśli manekin nadal nie reaguje, należy skontaktować 
z lokalnym przedstawicielem firmy Laerdal. 
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Wymiary ogólne 
Długość/szerokość (sam manekin): 48 cali x 9,84 cali (120 cm x 
42,5 cm) 
Ciężar (sam manekin): 25 funtów (11,36 kg) 
 
Zasilanie manekina 
Zasilanie zewnętrzne: Napięcie wejściowe 9 VDC, 1,5 A 
Akumulatorek: 7,4 V, 4,4 Ah, litowo-jonowy 
 
Do zasilania manekina SimJunior używać tylko zewnętrznego 
źródła energii i akumulatorków. 
 
Ciśnienie powietrza 
Wewnętrzny zbiornik powietrza:    Maks. 6 psi (413 hPa) 
Zewnętrzne złącze powietrza:    Maks. 16 psi (1103 hPa) 
 
Wartości graniczne temperatury 
Temperatura pracy: +4oC – 40oC (39oF – 104oF) 
Temperatura przechowywania: 15oC – 50oC (5oF – 
122oF) 
 
Środowisko – sam manekin 
Wilgotność względna: 20% – 90% (bez kondensacji) 
NIE UŻYWAĆ na wolnym powietrzu, w warunkach dużej 
wilgotności. 
Nie testowane z użyciem mgły solnej. 
 
Łączność radiowa 
Zakres roboczy: Maks. 10 m (30 stóp) 
 
Karta materiałowa manekina 
Ubranie:   Bawełna, nylon 
Skóra i drogi oddechowe:  PCW 
Zewnętrzne twarde  

tworzywa sztuczne:  PCW, ABS 
Wewnętrzne tworzywa  

sztuczne:   Silikon, TPU, PCW, nitryl 
     ABS, POM, nylon + GF 
   Żywica epoksydowo-

poliuretanowa 
Elementy metalowe:  Aluminium, mosiądz, stal 
 

Uwaga – lateks: Produkt zawiera lateks Natural Rubber, 
który może powodować reakcje alergiczne. 

 
Minimalne wymagania dotyczące 
komputera: 
 
•  Core 2 Duo lub lepszy 
•  1 GB RAM (zalecane 2 GB) 
•  1GB wolnej przestrzeni na twardym dysku, 
•  1024x768, 1280x800, 1280x1024 lub lepsza 
•  Rozdzielczość barw 16-bitowa lub lepsza 
•  Wymagane 100% DPI 
•  Napęd optyczny wymagany do instalacji 
 

Minimalne wymagania dotyczące 
oprogramowania: 
 
•  Windows XP lub Windows 7 
•  DotNet 3.5.1 
 
Płyny czyszczące 
Do czyszczenia manekina należy używać jednego 
z następujących środków: 
− 60-procentowy alkohol izopropylowy 
− 70-procentowy etanol 
− Łagodny wodny roztwór mydła w płynie 
 
Płyny do symulacji podawania dożylnego 
Do symulacji dostępu dożylnego i śródkostnego używać 
wyłącznie wody destylowanej lub dejonizowanej. 
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Numery katalogowe 
Symbol XX należy zastąpić numerem odpowiadającym lokalnej 
wersji językowej Więcej informacji można uzyskać, kontaktując 
się z miejscowym przedstawicielem firmy Laerdal. 
 
231-01150  Torba na manekin pełnowymiarowy pacjenta 

pediatrycznego 
232-05350  Waliza SimJunior 
210-05250  Waliza na urządzenia zewnętrzne 
5527   Gwarancja firmy Laerdal 
232-11950  Płytka CS z oprogramowaniem systemu 

SimJunior w wersji zaawansowanej i kluczem 
licencji 

232-11951  Klucz licencji do wersji zaawansowanej 
SimJunior (1) 

232-05050  Manekin SimJunior (jasny) 
200-100XX  Jednostka VitalSim, kompletna 
225-091XX  Urządzenie zewnętrzne, standardowe, bez 

monitora pacjenta 
225-090XX  Urządzenie zewnętrzne, zaawansowane, 

z monitorem pacjenta 
232-01250  Akumulatorek SimJunior (1) 
200-10550  Prostownik (uniwersalny) 
245-950XX  Monitor pacjenta 
245-980XX  Koncentrator USB 
245-96050  Kamera sieciowa 
232-00150  Koszula 
232-00250  Szorty 
232-00350  Bokserki 
300-00750  Płyn imitujący krew 
220-00250 Worek dostępu dożylnego 500 ml 
270-00250  Zestaw worka dostępu dożylnego 
232-03950  Mieszek unoszenia klatki piersiowej 
375-70150  Zestaw skóry/żył pediatryczny (jasny) 
200-03050  Zestaw wkładek źrenic (niebieskie) 
200-03050B  Zestaw wkładek źrenic (brązowe) 
375-71001  Prawa ręka z dostępem dożylnym 
232-01150  Lewa ręka z modułem pomiaru ciśnienia krwi 
232-00450  Skóra ręki z modułem pomiaru ciśnienia krwi 
231-00101  Zestaw nogi pediatrycznej z dostępem 

śródkostnym 
231-00750  Prawa noga pediatryczna z dostępem 

śródkostnym (jasna) 
232-00950  Skóra klatki piersiowej manekina SimJunior 
232-00750  Worek płuc SimJunior 
250-21050  Lubrykant do dróg oddechowych 45 ml 
276-15550  Środek czyszczący w płynie 
277-00150  Zasypka dla niemowląt 
232-00650  Mankiet do pomiaru ciśnienia krwi SimJunior 
05-10100  Złącze defibrylatora Zoll 
05-10000  Złączka Physio-Control Quick Combo 
945004  Złącze defibrylatora Philips 
232-19050  Instrukcja użytkowania 
232-00550  Skrócona instrukcja montażu 
277-00001  Zestaw pediatryczny ran pourazowych (jasny) 
 
Więcej informacji na temat części zamiennych i akcesoriów 
w innych odcieniach skóry można uzyskać, kontaktując się 
z przedstawicielem Działu Obsługi Klientów Laerdal. 
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